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This section contains information pertaining to the preparation of Legend and Symbol Information
Sheets, (hereinafter referred to as the Legend Sheet). Since plans contain multiple color sections,
multiple Legend Sheets must be included to define the use of color across those sections. The following
list of Legend Sheets shows which sheet letter series is covered by each one.

Plan and Profile Legend Sheet — Covers sheet series D, E, F, and K
Traffic Control and Staging Legend Sheet - Covers sheet series J
Storm Sewer Legend Sheet - Covers sheet series M
Soils Legend Sheet - Covers sheet series Q and R
Sidewalk Legend Sheet - Covers sheet series S
Cross Section Legend Sheet - Covers sheet series W, X, Y, and Z
Refer to Section 1F-5a for more information on Plan and Profile Legend and Symbol Information Sheets.

The Legend Sheet seed file, for the creation of a —olx
new Legend Sheet, is accessed through the _ RN = =
CopySeed program. The seed file contains several T Aavefie - 1 B BT X | o [»
models, each of which has a Legend Sheet for the Type | Name / | Description |
specific sheet series, as shown at the right. The El _LegendSurvey DesignerPlacedSurveylegend
designer should name the file CCRRRPPP_lgd.sht Bl A Sheetlegend Original A Sheet Legend - DEFAULT
and should only need to enter data into the E J[’—Ssh“:jl_':gg:n”dd ?-Sie;i:;eifh““'ege”d
_LegendSurvey model. = =

The “CCRRRPPP” Design File Naming B e
convention, refers to the 2-digit County, 3-digit Route, S Sheetlegend S Sheetlegend
and the 3-digit project Parenthesis number assigned E W Sheetlegend W.X.Y.and Z_Sheetleqend

to the project. See Design Manual section 20A-1

Creating a List of Project Specific Survey Symbols

Legend sheets are to contain a list of project specific survey symbols. To create this project specific list,
begin by attaching references of the Field_TOPO_0100 model of the .sur file, and/or the TOPO_0100
model of the .pho file to the _LegendSurvey model. Clip the referenced information to include only the
information specific to the current project. Using the Design and Computation (D & C) Manager, run
the Legend_Create tool, located as shown below:
D&C Manager (using the DesignV8.ddb file) >
Design Files >
All Files >
ODAC Tools >
Sheeting Tools >
Legend_Create

NOTE: The Legend_Create tool is intended to be used at 100 scale with 100 scale references from
the .pho and .sur files.

The Legend_Create tool is intended to be used in the ...lgd.sht file, and an error message will
display if it is accessed from within any other file type.
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After starting the Legend_Create tool, the Select Select Reference To Scan
Reference to Scan dialog should display, as shown at the
right. Using the drop-down selection arrow, select the
Field_TOPO_0100 model or the TOPO_0100 model.

If both the .pho and .sur files are used to generate the Cancel oK ‘
survey symbols, this process must be done for each
reference individually. NOTE: If the process is run twice,
the first set of data must be moved before the second set is placed directly on top of it.

Select Reference File to scan to biuld legend

| Field_ToPo_o100| |

Click the OK button, above. The Scanning process may x|
take a few moments to complete. While it is running, the
dialog shown at the right should appear, indicating the 2124 Elements Scanned

program progress.

The Place Legend dialog, shown at the right, will display at the 2 Place Lege — o] x|
same time as the Information dialog shown below. It is merely L
displaying the text parameters that have been set by the program. P Seecton e~
No action can be taken on this dialog, and it will disappear when the I o
Information dialog OK button is clicked, shown below. _ '

UneSpadngldDﬂDD
Place |

The Information dialog box, shown at the right, will

probably always appear after the legend creation process is
complete. It warns of the creation of the “feacode.err” file. @ S3amm Mt (e e I 60, S0 fzemsla e
(See below for instructions on reading the “error” file) Click

the OK button to continue.

The warning, at the right, indicates that symbols were
discovered in the Field_TOPO_0100 model and/or
TOPO_0100 model that do not appear in the SMD file. However, these symbols may be available
through D & C Manager, which indicates that D & C Manager and the SMD are out of sync. Using the
Notepad program, open the feacode.err file, (stored in the same location as the _Igd.sht file). Review
the information in the file to determine if additional symbols should be added to the legend. The figure
below shows a sample of a feacode.err file. The text in parenthesis relates to programmatic decisions
made about each feature that was not found in the SMD.

B feacode.err - Notepad g@§|
File Edit Format Wew Help

LEGEMND -- Feature [TLNM] not found in sMD (In D& Manager--out of sync with sSMD--Contact oDaC)
LEGEMND -- Feature [PvP] not found in sMmD (In D& Manager--out of sync with sSMD--Contact oDaC)
LEGEMND -- Feature [FB] not found in sMD (In D&C Manager--out of sync with sSMD--Contact oDac)
LEGEND -- Feature [Brush & Trees] not found in sMD (Descriptive text—-omit)

LESEND —- Feature [Building] not found in smD (Descriptive text--omit)

LEGEND -- Feature [House] not found in sMD (Descriptive text--omit)

LEGEMND -- Feature [Garage] not found in sMD (Descriptive text--omit)

LEGEMD —— Feature [shed] not found in smMmD (Descriptive text--omit)

LEGEND -- Feature [CuLlpPLOT] not found in sMD (Linestyle——omit)

LEGEMND -- Feature [PMP] not found in sMmD (Linestyle——omit)

LEGEND -- Feature [511o] not found in sMD (Descriptive text--omit)

LEGEND -- Feature [Pond] not found in sMmD (Descriptive text—-omit)

NOTE: The Legend_Create program is unable to override the settings defined in the SMD file, so the
text corresponding to the Survey Symbol list may have incorrect attributes that must be changed
manually. The correct attributes for text corresponding to the survey symbol list are:

Level: dsnTextFinalPlan (ByLevel settings) Font: 36 Road_Design_General (Th: 13, Tw: 13)

To add any of the missing symbols to the Survey Symbol list, see the instructions in Correcting the
Survey Symbol list section, found below.

Page 2 of 5



Chapter 21—Automation Tools Instructions

Section 21A-52—Legend and Symbol Information Sheets

When the above mentioned Scan process is complete, a list of project 5
specific survey symbols will have been generated at the lower left
corner of the _LegendSurvey Model. The list of Survey Symbol
items will be located within two vertically stacked boxes (not shown i
here) that represent two possible columns of data to be referenced to -
the Legend Sheet. A partial list example is shown at the right.

The Survey Symbol list, (mentioned above),
will be automatically referenced to the left side
of the Legend Sheet in the D, M, Q, and

S Sheet Legend models, as shown at the
right.

If the list of symbols is long enough, it will be
referenced to the Legend Sheet in two
columns. The layout of the legend sheets
accommodates only two columns of survey
symbols.

S e

Correcting the Survey Symbol list

For the purpose of the display on the Legend Sheet, the
line styles used in the _lgd.sht file Survey Symbols list are
scaled by a factor of five for the 100 scale file, but the
symbols (cells) in the legend are copied at the same scale
as in the .sur and .pho files.

To correct any erroneous symbols, use the utilities that are
found in the Stereo Plotter folder of the D & C Manager,
as shown at the right.

The Survey Symbols inthe _LegendSurvey Model,
generated by the Legend_Create tool, should be checked
to make sure erroneous items are not present.
Unnecessary items, such as those that have been crossed
out in the example at the right, should be removed from the
legend. Any other line styles that are unnecessary for this
Survey Symbol list, such as “back of curb” and “sidewalk”,
should also be removed. The remaining items should be
manually moved upwards in the list to close up the gap(s)
caused by removing unwanted items and to maintain
consistent spacing between items. (Spacing is set at a 40 ft
increment.) See below for details on realigning the
remaining items.

i Design and Computation Manager

€UM Luminaire

* TSG Traffic Signal /

PPA Power Pole Co. 1

PR Electic Riser Pole

- -~ ~TCE M " g BEV

AT G

Survey Symbols

PLAN AMD PROFILE
LEGEND AND SYMBOL
INFORMATION SHEET

L TR e B L P B S
1 T [ ET

o=

File Edit 3Settings Favorites Help

g id eqh

&2y \highwayhDesign'CaD DG eopak \DCM anageriDesignt/s #
(7= Design Files
3 Al Files
23 Alternatives [alt)
£ Methods [mtd]
(= Photogrammetry [ pha)
Photogrammetiy File Instructions
£ Comtours [Contours)
[ Topography (Features)
Featurez Madel Instructions

nistructions
3 Cells
£ Line wWork
£ Descriptions
3 Tools

23 Survey Processing

£ Utility Lines ha

WHD Water Hydrant

TSRO R B e ) 14 o
WowWIlo Ccara TEIO ooty

v -
™MISCL T

SEP Septic Tank

AST Above Ground Storage Tank

MO 1 o
¥ VO Iey ST tIorT

5P Stream Profile

B fud TR R W]
CITw  CRIreme TIIgm water
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To realign the items to maintain the original 40-foot

spacing, after erroneous items have been removed, < Design and Computation Manager Q@JE|
use the Legend_Space Text Vertically Tool from D & Eile Edit Zeftings Favorites Help
C Manager as shown at the right. First, create a . - ]
: : - == id ﬂ v Lt
selection set of all symbols and text and then input ‘40’ @ ¢ h
into the ‘Enter Distance Between Rows’ field as am vy whighvaps D esignCAD DG eopak\D CM anagerDesigrive #
shown below. Select the OK button. (2= Diesign Files
= Al Files
[ ODAC Tools
: | netructions
Vertically Space Text r$_<| £ CPM Tals
— 27 General Tools
Include in a Selection 5et all Text and 20 Maripulate Elemsits

23 Manipulate Files, Models Levels
[ Sheeting Toaols

Batch Print Shape Placement [working Model)
Enter Distance Between Rows 40) Border [Send To Back)/(Copy Print Border]
Lawout Builder
Legend Create

Symbols to process!

B | egend Space Text Vertically
Mew Level Lock for References

Zancel ‘ (04
totif Builder [GEOPAK. Sheeting) v

Creating a Project Specific Utility Legend

The symbols in the Project Specific Utility L
Legend list provide Utility Ownership =
information, unlike the generic information in oo ,
the Survey Symbols list. Utility information =
should be placed in the Utility Legend Box in
the _LegendSurvey model. The Utility =
Ownership information is first referenced from —ns
the Field_G_Sheets model of the .sur file. S
The referenced Utility information should then
be copied to the _LegendSurvey model. It
should be edited, as appropriate, to include
only the utilities that pertain to the current Eiito a0 Srveo.
project limits. The Utility information is to be AT
placed in the center of the Legend Sheet, as e L R S
shown at the right.

= Project Specific
Utility Legend

—J

INFORMATION SHEET

If Utility Contact Information is available (found in the Project Scheduling System [PSS] and limited to
the project specific utilities by the District Utility Coordinator), then that information should be input
manually into the Utility Legend Box. This information includes the utility contact's name, as well as the
company address, phone number, and email, if available. Refer to the sample legend and symbol
information sheet for further guidance.

For direction on how to obtain utility contact information from PSS, refer to Section 21A-503.

If the utility contact information obtained from PSS is not a one-to-one match with the utility legend from
the Field_G_Sheets model, then the designer must contact the District Utility Coordinator for updated
contact information. If the District Utility Coordinator does not provide updated contact information, only
the information provided in the Field_G_Sheets model may be shown in the legend.

NOTE: Designers must input survey symbols and a utility legend that are specific to the current
project. This may or may not include the entire surveyed area.
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Legend and Symbol Information Sheet Batch Printing

The Legend and Symbol Information Sheet (Legend Sheet) is normally the first sheet of the associated
series of sheets and should be numbered accordingly, such as D.1, M.1, etc. However, an exception to
this rule is that the Legend Sheet for the Traffic Control and Staging information is to follow the tabulation
sheets in the “J” sheet series, as instructed in Section 1F-10. This will cause the “J” Legend Sheet to be
embedded in the middle of the “J” sheet series, and numbered accordingly.

To Batch Print a Legend Sheet with the other sheets associated with the same sheet letter, both the
_lgd.sht file and the other .sht file(s) are to be added to the “Print List” during the Batch Print procedure
setup. Inthe Batch Print dialog, as shown below, the order of the models can be changed by “dragging”
a model name up or down to any specific location in the list. The models should be arranged so the
Legend Sheet is in the proper print location with respect to the other sheets.

The Batch Print dialog, shown below, is an example of printing the D sheet series with the Plan and
Profile Legend Sheet. Unnecessary Legend models should normally be deleted from the batch print
listing.

0} [untitled] - Batch Print
File Edit Specifications

DN d&s 3 XE B s

Specifications Contralling Printing

Frinter: 11417 _chr_over-ides_PDF_Plotz
Print Area: Reference_dsnShtPlotShapeB atchPrint
I aximize to Paper size
ApplyLin ightz and FullColor
# | File Madel Dezcription -
1w \nghway\D93|gn\Methods...\58081 113 lgd.sht A SheetLegend Original & Sheet Legend - DEFAULT
2 L', 0 61113 |gd.sht Sheetl_egend . etlege
3w \nghway\Demgn\Methods...\58081 113 | lgd.sht LegendSurvey DesignerPlacedSurveylLegend
4 whiiHighwaysDesigntbethods, \BE0E1113 lgd.sht  J_SheetLegend J_SheetLegend
5 wiiHighwayiDesignthethods.. \BE0E1113_lgd.sht  M_SheetLegend M_5Sheetl egend
B wHighwayhDesignihethods. \GEB0G1113_ lgd.sht  (_Sheetlegend (1 and Ai_SheetLegend
7w \nghway\Demgn\Methods...\58081 113 lgd.sht W Sheetlegend WY, and 2_Sheetlegend
2 haster Model
g 0 ated by the GE ..

If the unwanted models are not deleted from the list, then only the
models to be printed should be selected. After File > Print has been
initiated from the dialog shown above, the Print Range option should be
toggled to ‘Selection,’” as shown at the right.

Print Batch

— Print Range

f'[MS_PLTFILES batchph lod

¥ Clear Log File Before Printi

el e

For further information on MicroStation Batch Printing, refer to Section 21E-1.
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Chronology of Changes to Design Manual Section:
021A-052 |egend and Symbol Information Sheets

9/30/2011 Revised
Corrected graphic examples and links.

7/5/2011 Revised
Updated to include vertical spacing tool , utility contact information, 'S' Sheet infromation, and link to sample
legend sheet.

3/23/2011 NEW
New Section
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